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Welcome From The Chief Editor
Over at Linux.com, Carla Schroder gave a shining
review of the latest release of PCLinuxOS. Now
Carla isn’t known as someone who hands out praise
easily or quickly. She’s typically one “tough cookie”
with her reviews. She tells you, in no uncertain
terms, what she thinks. She also isn’t known for
“sugar coating” her opinion, either. As some of you
who read reviews of Linux distros, they can
sometimes seem trivial and trite, or they can be
particularly nasty and scathing.

Texstar continues at the packaging helm while Neal
recuperates from his recent hospitalization. Now
back at home, I suspect it won’t be long before Neal
is helping Texstar with the packaging chores and
helping to keep everything tuned up and running
well. Meanwhile, Texstar has been working on
updating the toolchain, xorg, Intel graphic
drivers, the kernel, and adding the Steam
for Linux gaming client to the testing
section of the PCLinuxOS repos. To top it
all off, Texstar has been having fun in the
PCLinuxOS forum with more regularity.
In other news, Daniel, a.k.a. Leiche, has
stepped away from creating the LXDE ISO.
So, the search is on for someone else to
maintain the LXDE releases. Fans of
LXDE should have little to fear, since a
new LXDE version was recently released.
Someone among the community is certain
to pick up the LXDE torch.

Towards the end of her review, Carla sings the
praise of The PCLinuxOS Magazine. That’s right.
The very magazine you are reading. Carla says:
“Every Linux user should read PCLinuxOS Magazine,
because it is a beautiful production full of great articles.”
To be perfectly honest, I am quite proud of Carla’s
comment about the magazine that has been under
my stewardship for the past four years. I’m
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Disclaimer

especially proud, since it came from Carla. So,
thanks Carla, for noticing our work on The
PCLinuxOS Magazine.

Like music to the ears of all e17 fans,
Texstar has also compiled and released
the newest version of the Enlightenment
(e17) desktop, which can be installed via
Synaptic by searching for and installing the
desktop. Agust has even reappeared to update his
ever popular themes for the Enlightenment desktop
to the newest, latest e17 version.
Until next month, I bid you peace, happiness,
serenity and prosperity.

1.

All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2.

The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3.

The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4.

No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5.

Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.
Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.
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GIMP Tutorial: Create Your Own Alien World
by Meemaw

See all the dots inside the sky? I don’t want that.
Sometimes the selection doesn’t include all the area
you would like it to. A way to remedy that is to set
the threshold up a bit and click again. (Threshold is
in the Select by Color tool options at bottom left.)
Keep doing that until your sky is outlined and all the
other dots, if there are any, are outside it.

I was sent a cool tutorial the other day. It’s got
several useful manipulation methods in it and I’m
going to share it. When you are finished, you’ll have
something similar to this:

I’m first going to add an alpha channel to each layer
so we can make part of each transparent. Rightclick
on each layer and choose “Add Alpha Channel”.
Now I will put the mountain layer on top and “turn
off” the water layer by clicking the eye to the left of it
in the layers tab.

This a three part process: editing the land, creating
the starry sky and then the planets.
The first thing I did was find a couple of
photographs: one of mountains and one of the
seashore. Opening Gimp, you need to click File >
Open as Layers.... and navigate to the folder
where you saved your photographs. Choose them
by clicking the first and then pressing the <CTRL>
key while you click on the other. (Remember,
multiple select uses <CTRL> or <Shift> depending
on how many you are selecting.) I moved one layer
so you could see them both (center, top), but you
don’t have to do that.
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I just want to use the mountains, so I’m going to
choose the select by color tool and click on the sky.

Now choose your eraser, using a hard brush, and
erase the sky. Be careful next to any similar colored
mountain you want to use. In mine, the mountain in
the background is too hazy for me, so if I erase part
of it, I’m not going to worry, because I’m going to
clone another mountain into that spot.
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GIMP Tutorial: Create Your Own Alien World
Click Select > None to remove your selection. That
turns off all the moving dotted lines.
With the clone tool, we’ll use the same technique we
used for taking the road sign out of a photo, except
this time we will pick a piece of the existing mountain
(using a soft brush), hold <CTRL>, and brush across
it. Then go to the place you want a mountain and
paint there. If it doesn’t turn out the way you want it
the first time you can always undo part of it (<CTRL>
+ Z) and try again. Save your work if you are
satisfied (Remember, saving as a Gimp xcf file
deletes your undo history, so only save it when you
are happy with what you have done.)

back up and finish your erasing. You can also move
your layers around on the page to get the effect you
want as well. I moved the water layer down to show
more mountains.

If you are happy with your work up to now, rightclick
on the top layer and choose Merge Down, then save
your work.

Now we can make the water layer visible again by
clicking the eye icon on that layer. Move it to the top,
too. What I want to do is stack these layers so it
looks like there is a cove or lake with hills around it,
so we’re going to erase the sky and part of the
water.
To be able to see what we are doing in relation to
the bottom, mountain layer, set the Opacity on this
layer to about 50%. Using a hard brush, start
erasing the top layer until you like the way it looks.
When you get part of your water erased and want to
see what you are doing, you can set the opacity
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Let’s do the sky now. First, make the mountain/water
layer invisible for now. Then, in the Layers dialog,
click on Create New Layer. Choose Fill with
Foreground Color (since we haven’t changed
anything, your foreground color should be black). On
this layer, click Filters > Noise > HSV Noise. In the
configuration box that pops up, move the Value
slider all the way to the right, then click OK (top,
right).
We want a little variety, so click on Filters > Light &
Shadow > Sparkle. Leave the settings as they are
and click OK (center, right).
However, this is a little too sparkly for my taste, so
Create a New Layer (black). In the new layer,
choose Filters > Render > Clouds > Difference
Clouds. Then, in the Layer dialog, change the mode
of this layer from Normal to Burn (bottom, right).
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GIMP Tutorial: Create Your Own Alien World
Now your stars look more varied. Merge these three
layers.

An alien world wouldn’t be complete without some
nearby planets!

We want to add a little color to the stars, so create a
new black layer. Click Filters > Render > Clouds >
Plasma. Then change your layer mode to Dodge.

Create a new layer, but make it square, and a little
more than half the height of your project on each
side. My drawing is about 750 pixels, so I’m going to
make this new layer a 400 pixel square. Pick a red
color and bucket fill it.

You should study your layer a bit before you
proceed. The top is going to be visible, but not the
bottom. You can flip your layer using the Flip tool if
you wish. Make sure it is set on Vertical before you
click on your layer to flip it. Right click and Anchor
layer if needed. Now you can “turn on” your land
layer and bring it to the front.

Now choose the paintbrush. Change it to another
brush style, like acrylic (I chose acrylic02). Choose a
brown color, increase the size of your brush to 150
or 200 and paint inside your layer. Don’t cover all the
red, though.

Now we are going to make it into a sphere. Click on
Filters > Map > Map Object. We’ll change some of
these settings:
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Main Window: Uncheck Show wireframe and check
Show preview live.
General Tab: Choose Map to Sphere and check
Transparent Background.
Light Tab: Change from Point Light to Directional
Light. This removes that small light reflection as our
light source will be farther away.
Materials Tab: Change Ambient to 0.20 and
Specular to 0.00. This darkens our sphere a bit.
Orientation Tab: Change the Position Slider for Z to
0.90000. This makes our sphere larger.
Click OK.

Using the Move tool, you can move it anywhere you
want it, and move the layer down under the land
layer so it looks farther away.
Before we finish with this layer, we want to add
some light to one side of it to give our picture the
feeling of a light source. With your planet layer
selected, rightclick in the layer tab and choose
Alpha to Selection. This chooses only the planet.
Select the Blend tool, then choose as your gradient
FG to Transparent with the foreground white and the
transparent on the left. Also, choose a radial
gradient, because we want the white around the
edge of the planet, and change the offset to 85.
Starting from just below and to the right of the center
of your planet, hold and drag your mouse pointer up
and left to just outside the planet (next page, top
left).
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GIMP Tutorial: Create Your Own Alien World
Filters > Render >Clouds > Plasma. Now, click on
Filters, but go to Recently Used, and choose Map
Object. then Alpha to Selection again, and choose
your blend tool and add your light.

Cool,
huh?
Click
Select > None to
unselect everything.

Let’s make it a little
more alien. Choose
your land layer, click
on
Colors
>
Brightness
&
Contrast, and set the
color down and the
contrast up to change
the colors a bit. When
you are satisfied with
your work, save. If you
are sure you are
finished you can merge
all your layers by choosing Image > Flatten Image.

As a final feature in our
project, let’s put one
supernova in our picture.
Click Filters > Light &
Shadow > Supernova.
The crosshairs show where
it will be on your picture,
and you can make it as
bright and as big or small
as you want by changing
the color, radius and
number of spokes. I left the
defaults.
If you don’t want to mess with the photographs, you
can just make the sky and the planets, which is fun,
too. Experiment with different settings & colors and
see what you get!

Now I’m going to
make another planet a
little smaller than the
first. I made my new
layer 300 x 300, filled it with an orange, then using a
brown, clicked over it with a different brush (I used
one called Galaxy). Since you have already made a
sphere, all you need to do is choose Filters >
Repeat Map Object. All the settings are already
there, so just click OK. Alpha to Selection, as before,
then choose your blend tool and add your light.
Let’s
make
one
more
planet,
smaller than
either of the
other
two
(150 x 150 in
a new layer).
Instead
of
painting
it,
Click
on
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Windows Migration:
The Terminal – Basic Operations

by Peter Kelly (critter)

by PCLinuxOS to handle software installation,
removal and upgrade.

Windows command line vs Linux command line

Each command accepts zero or more options that
control the output from the command and the way in
which the command operates upon the data that it is
required to process. There are sometimes modifiers
to these options which fine tune the action of the
command and then, finally, there are the arguments
or data that is supplied to the function for
processing.

In recent years, the tools available to Windows users
have improved considerably and many commands
previously found only in Unix/Linux systems have
found their way onto the MS command line. Many of
the commands have similar options to those
available under Linux, but there are differences.
For those users that are familiar with the MS
command line I will show the MS command with the
Linux command, where appropriate, like this ls (MS
= dir). Actually, under PCLinuxOS, the command dir
is is an acceptable alternative to ls but not all
distributions support this.
How the commands work
Commands entered on the command line in Linux,
such as ls, tend to have short names to reduce and
to speed up typing. They are normally designed to
perform a very basic function but usually will accept
many options that enhance the basic function and
permit the user to control, often to a very high
degree, the effect that the function has upon the
data passed to it and/or the output that is produced.
To better understand the command line we need to
know how Linux commands operate. Although Linux
commands are plentiful, and diverse in their
operation, the basic operation is mostly the same.
A command does one thing and one thing only. The
command ls lists, cd (MS = cd) changes directories,
sort (MS = sort) sorts and the rpm command
(redhat package manager) controls the system used
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Don't be alarmed if all of this sounds too complex.
The basic command will usually suffice – everything
after that is usually optional but available if you want
tailormade results. Some commands have an
overwhelming list of options and modifiers, more
than any sane person could possibly remember, but
you can use only what you want or need. To find out
what is available, type the command name followed
by help or – h. This usually produces a brief
summary of the options available for the command.
By now you may be wondering what commands are
available. Type a single letter, any letter, and press
the tab key (you may be prompted to type y or n),
then this will list all of the available commands that
begin with that letter.
To demonstrate the use of commands, I will use only
the simple command ls, and its options, modifiers
and arguments. This command will not change or
remove any files so you can safely experiment with
it.
Permissions and groups
Before we can go any further with this introduction,
there are some things that need to be explained as

they are different in Linux from the way that you are
used to working in Windows. Although it is possible
to use permissions and groups under modern
versions of MS Windows using access control lists,
most Windows users are blissfully unaware of their
existence or of the use of MS commands such as
CACLS. Linux, on the other hand, makes strenuous
use of them. Fortunately they are not difficult to
understand.
Look again at the output from the command ls al.

That is only part of the output, but I think that we
need an explanation here as this is entirely different
from Windows. The first letter on each line describes
the type of file  d means a directory and – means
an ordinary file. There are others too, such as l for
links to other files which are similar in nature to
shortcuts in Windows. The next nine (actually three
sets of three characters) are permissions. This is
fundamental to the Linux file system and often a
source of confusion to new users who can't
understand why they are refused access to a file.
Let's get this out of the way now.
Permissions
In the introduction, I said that Linux was a multiuser
system and that each user was given his own home
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directory. This would not be a very convenient
situation for you if other users could see, edit or
delete your files. But sometimes you will want to
share some files with other people, but not with
everybody, and this is where permissions and
groups help. Didn't I mention groups? Sorry, but I'm
afraid that you have to also learn about those, but
there is nothing that is difficult.
Every file or directory is given a set of permissions
when created that allow users to read, write or
execute them. Read and write are pretty obvious.
Execute, when applied to an ordinary file, allows the
system to run programs and scripts. For a directory,
it means that you may make changes to it or list the
contents. If a permission is granted then a r ,w or x
appears at the appropriate position. If a hyphen – is
present, then that permission has not been granted.
Why three sets of permissions? These are the
permissions for
* The owner, usually the person who created the file
or directory (the first set of three characters)
* Members of the group to which the file belongs
(the second set of three characters)
* Everybody else (the final set of three characters).
Groups
Obviously you would want read and write permission
for your own files and execute permission for your
scripts, and for any files you own, that are, well,
executable. Everyone else you would want to deny.
Well, perhaps not everybody. Some things are
meant to be shared and this is where groups come
in.
When a user account is created, that user is given a
group of their own and is added to various other
groups as decided by the system administrator or
the distribution development team. To be able to use
the printer, you need to be a member of the lp
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group. You can see which groups you belong to with
the command groups.
So a file with the nine letters set as rw r  would
mean that the file may be read and written to but not
executed by the owner of the file, a member of the
group to which the file belongs may only read the
file, but everybody else has no access whatsoever
(except, of course, the omnipotent root who sees
all).

Options, modifiers and arguments
You can find out what options are available for the ls
command with the command ls help.
Some of the options may be meaningless to you and
you can just ignore them. If you don't understand
them, then you probably don't need them. A useful
one for the ls command is h which gives the size of
a file in human readable form so that a file of
2048558360 bytes displays as 2.0G.
If you type ls lS, then you are issuing the command
ls and passing the options l and S which tells the
command to generate a long listing which is Sorted
by file size. But what if you want to have the listing
sorted by some other criteria such as filename
extension, as you might in a folder full of picture files
with various .bmp .jpg and .png extensions? In this
case you might use the option

In the above listing, the directory 'Projects' belongs
to the group 'projectteam' and the group
permissions have been set to allow members of that
group to enter the directory, read the contents of the
directory and to write files to the directory. However,
unless the files in the directory have read/write
permissions for this group, the group members will
not be able to read or modify them. The Projects
directory has no permissions set in the last three
positions, so users who do not belong to the group
can't even look inside the directory.
After the nine letters is a number, which need not
concern us right now. This is followed by the name
of the owner of the file and then by the group of
users who have access to the file. After this we get
the file’s size, timestamp and the name of the file.
Advertisement

sort and then add the modifier 'extension' like this
ls l sort=extension
The sort option allows the following modifier
words: none, extension, size, time and version. In
the time honoured tradition of Linux/Unix users
being lazy typists, this can be abbreviated to the first
letter of the modifier like this
ls l sort=e
Note that Linux does not use filename extensions to
determine the file type as Windows does but
extensions are often used to aid human users
quickly recognize a file type. However, this can be
misleading as a text file named mytext.bmp is still a
text file. To determine correctly the type of a file
under Linux you should use the file command.
myfile.bmp
myfile.bmp: ASCII text
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A graphical image file would produce output like this:
file /usr/share/icons/pclinuxos.png
/usr/share/icons/pclinuxos.png: PNG image data,
32 x 32, 8bit/color RGBA, noninterlacedfile
That leaves arguments to be demystified.
Arguments are the information that you pass to the
command. The default argument for the ls command
is 'the current working directory' which is what it will
list out if you pass no other arguments to the
command. You may pass more than one argument
to the command.
ls l ~/Pictures ~/Documents
This command will list first the contents of your
Pictures directory (there's that squiggle again) and
then the contents of your Documents directory.
Remember, the squiggly character or tilde is used as
a shorthand way of saying “my home directory”.
In practice you will use very few of the options
available with the ls command unless you start
writing shell scripts or spend a lot of time on the
command line but if you understand the basic usage
demonstrated here then you can apply this to almost
all of the Linux command line tools. Now it is time
that we looked further than the simple ls command
and considered some of the other commands that
are available.
File Handling
As an ordinary user you have permissions to enter
and list the contents of most directories but not to
change or delete anything except for those sub
directories in your home directory. To change to
another directory use the command
cd directoryname
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For example, cd /etc would put you in the /etc
directory. cd on its own will take you back to your
home directory. To change to your Documents
directory you could type
cd /home/linux_user/Documents,
shorthand cd ~/Documents.

or

use

the

Remember the squiggle?
To rename a file we use the mv (MS = move)
command
mv oldfilename newfilename The new file
name may optionally include the address of a
directory to which we have write permissions.
Deleting a file or files is accomplished with the rm
(MS = del or delete) command
rm filename Be careful of this one as there is no
undelete command. The PCLinuxOS version of this
command will prompt you for confirmation before
sending the file to oblivion but this is not always the
case.
To make a new directory you need to have write
permission for the directory where you want to place
it and you use the command mkdir (MS = md or
mkdir).
mkdir directoryname.
You can remove an empty directory with the
command rmdir (MS = rd or rmdir)
rmdir directoryname
To remove a directory and all the files that it contains
you will need to use the rm command with the
option r (MS = deltree). If there are many files in the
directory then the prompting can become quite
tedious but you can turn it off with the f (force)
option.

Important
Be very, very careful with this. It is
ruthless, quick and permanent. A little trick that I
often use is to replace rm rf with ls R to list out
which files would be deleted. If that is what I
intended then I issue the rm rf death warrant. The
R option tells the ls command to recurse down
through any subdirectories to show everything that
would be deleted (make sure that you use upper
case R as lower case r will only reverse the listing).
To look at the contents of a file we have the cat (MS
= type) command (short for concatenate which just
means to join together) Try
cat /etc/fstab
This will display the contents of the file that tells the
system where to mount your file systems. You can
also use the cat command to create a simple file
without having to open an editor by using the
redirection method which we previously discussed.
cat > newfile
This is telling the cat command to redirect its output
to the file newfile which it will create if necessary. As
we haven't passed to the cat command any file as
an argument for it to process it looks for input from
stdin, the keyboard, and it will just sit there waiting
for somebody to start typing. Type whatever you
need and press return whenever you want to start a
new line. When you have finished typing, hold down
the control key and press 'd'. This sends the shell an
invisible character known as an endoffile character
or EOF. The file is then written and closed.
You can create a new, empty file with the touch
command
touch filename
This is useful where you are using a command that
doesn't automatically create a file when needed. You
can create an empty container ready to accept the
output from the command.
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Often you need to refer to a file that is buried deep in
a subdirectory and an easy way to do that is, as in
Windows, to create a shortcut to it although the
manner in which Windows and Linux accomplish this
are entirely incompatible. In Linux there are two
types of shortcut and they are known as links.
There are hard links and soft or symbolic links. For
now we will concentrate only on soft links. The
command to create them is ln or ln s for a soft link.

Reach Us On The Web

ln s
/home/linux_user/Documents/invoices/November
/Acme_inc.txt acme_11

PCLinuxOS Magazine Web Site:
http://pclosmag.com/

will create a shortcut named acme_11 which will
point to the buried file making it easier to load into a
text editor for example. This is very useful for editing
things like system scripts without having to
remember where they are.
When you receive some output from a command, it
invariably is not in the order that you would like it. To
sort it into the required order we use a command
called, naturally, sort.

PCLinuxOS Magazine Mailing List:
http://groups.google.com/group/pclinuxosmagazine

That should give you a start in command line use
under Linux. In the next article we shall look at some
more of the most commonly used Linux commands.

PCLinuxOS Magazine Forums:
http://www.pclinuxos.com/forum/index.php?board=34.0

Screenshot
Screenshot Showcase
Showcase

There are many options for sort to produce data
sorted alphabetically, numerically, reversed, by date
etc. The sort command is one of many Linux tools
known as a filter. Data is passed to a filter and the
output is the altered data. This is one of the basics of
command line operation and part of the real power
of Linux. The usual way of using a filter is to
separate the command producing the data from the
filter with the vertical bar character known as a pipe.
Like this:
Advertisement
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Windows Migration:
The Terminal – Some Common Commands

by Peter Kelly (critter)
The commands

To start you off on your journey of discovery into the
world of the Linux command line, I describe below
some of the most common commands that I use.
There are so many commands available in the Linux
toolbox that every user will have their own set of
mostused commands. Here are fifty of mine:
apropos, cal, cat, cd, chmod, chown, clear, cp, cut,
date, df, dmesg, du, exit, file, find, free, grep, gzip,
head, info, kill, less, ln, locate, lp, ls, man, mkdir,
mount, mv, nano, passwd, ps, pwd, rm, rmdir,
shutdown, sort, su, tac, tail, tar, top, touch, tr,
umount, uname, whatis, whereis.
That's it, not that many, really. These are not
necessarily the most used commands in Linux but if
you can use these then you should have no
problems with the others. Get used to using these
few commands and you will feel a lot more
comfortable using a terminal. Nine of the commands
we have already met, but I will repeat them for
reference.
Getting Help
When starting to use the terminal, the one thing that
you need is help. These next commands will get you
that help.
Most commands come with a user manual which
can be accessed with the command
man commandname e.g. man ls (MS = help or
command /?)
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Navigate with the up, down, page up and page down
keys. Get out by pressing the q key. If you need
more information than you get in the manual, then
try the commands handbook which you get to see
with the command
info commandname

cd /home/linux_user/Documents or use
shorthand cd ~/Documents. Remember
squiggle?

the
the

To make a copy of a file, use the cp (MS = copy)
command

When you don't know the name of a command, try
the apropos command with some relevant text

cp filename destination the destination may
include the directories describing the path to the
copy of the file but those directories must already
exist, and you must have write permission for at
least the final directory in the path.

apropos cdrom will list all commands it knows of
that have cdrom in their description.

To copy directories recursively, use cp R (MS =
xcopy)

If you know the name of a command, but are unsure
what it does try

To rename a file, we use the
mv oldfilename newfilename command (MS =
rename or move). The new file name may optionally
include the address of a directory to which we have
write permissions. To delete a file, we use this
command

navigation is the same as for the man command.

whatis commandname to get a short description.
Should you need to know where a command and all
of its its associated files are stored, then
whereis commandname
information.

will

get

you

that

File Handling
As an ordinary user you have permissions to enter
and list the contents of most directories, but not to
change or delete anything except for those sub
directories in your home directory. To change to
another directory, use the command
cd directoryname (MS = cd) for example cd /etc
would put you in the /etc directory. cd on its own will
take you back to your home directory. To change to
your Documents directory, you could type

rm filename (MS = del or erase) Be careful of this
one as there is no undelete command. The
PCLinuxOS version of this command will prompt you
for confirmation before sending the file to oblivion,
but this is not always the case.
To make a new directory, you need to have write
permission for the directory where you want to place
it and you use the command
mkdir directoryname. (MS = md or mkdir)
You can remove an empty directory with the
command
rmdir directoryname (MS = deltree)
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To remove a directory and all the files that it contains
you will need to use the rm command with the
option r. If there are many files in the directory then
the prompting can become quite tedious, but you
can turn it off with the f (force) option.

There are three groups of permissions: owner, group
and everybody else.

Linux keeps a database of most of its system files.
To find the location of a system file, use the

There are also three types of permission: read, write
and execute.

Important Be very, very careful with this. It is
ruthless, quick and permanent. A little trick I use is to
replace rm rf with ls R to list out which files would
be deleted. If that is what I intended, then I issue the
rm rf death warrant. The R option recurses down
through any subdirectories (make sure that you use
uppercase R as lower case r will only reverse the
listing.)

Read =4, Write = 2 and execute = 1.

locate filename command. A file that often needs
to be edited is called fstab and is usually found in
the /etc directory. When you can't remember where it
is, use locate fstab and it will tell you.

You can create a new, empty file with the command
touch filename
Often you need to refer to a file that is buried deep in
a subdirectory and an easy way to do that, as in
Windows, is to create a shortcut to it. In Linux there
are two types of shortcut and they are known as
links. There are hard links and soft or symbolic links.
For now, we will concentrate only on soft links. The
command to create them is
ln or ln s for a soft link (MS = assign).
ln s /home/linux_user/Documents
/invoices/November/Acme_inc.txt acme_11
will create a shortcut named acme_11 which will
point to the buried file making it easier to load into a
text editor for example. This is very useful for editing
things like system scripts without having to
remember where they are.
Changing the permissions of a file requires the use
of the chmod (change mode) command (MS =
attrib). This command accepts several ways of
specifying the new permissions and this can, at first,
be quite confusing. To keep it simple, I use the
following method.
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Add them up for each group of permissions like this
owner read + write = 4 +2 =6
group read = 4
everybody else no access = 0

You may sometimes be asked what kernel the
operating system that you are logged into is using,
and what is the architecture of the machine (32bit,
64bit etc.).
uname a gives all of that, the a means all, other
options restrict the output.

chmod 640 myfile done!

To discover how much memory you have and how
much is being used, use this command.

Information

free (MS = mem) use the m and g options to
display the results in MB and GB respectively. Linux
doesn't use filename extensions to identify the type
of data a file contains, sure, they are often used, but
that is mostly for user convenience. The file
command will tell you what type of data is in a file.

There are many ways to get information from the
system and these next commands will give you most
of what you need.
ls (MS = dir) as we have seen will list the contents of
a directory.
pwd (MS = chdir) print working directory. This
confirms where you are with the file system.
date (MS = date or time) This command typed on its
own will print out the current date and time. This
command can also be used to set the system date
and time, but this is done so much better by the
PCLinuxOS control center.
When you need to refer to a calendar in a hurry, just
type
cal and you will get a nicely formatted calendar for
the current month. cal 3 adds the previous and next
months, cal y gives a full year and cal 1066 will
give historians a calendar for the year of the battle of
Hastings.

The find command is one of those commands that is
at the same time immensely powerful, indispensable
and annoyingly complex to new command line
users. Its syntax is slightly different from most Linux
commands, but its use can be simplified to provide a
more useful, basic utility. The syntax of the
command looks like this:
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find wheretolook options filecriteriatolookfor
whattomatch

We send all error messages to a black hole called
/dev/null

Here we can use another filter command to control
the output.

Wheretolook is the directory in which to start the
search.

find / size +100M 2>/dev/null

tail will, by default, show only the last 10 lines of the
file. tail n 20 will give you twenty lines. To use the
filter we need to use the pipe character again.

Options include things like maxdepth 1 to restrict
the search to the top level directory specified.
Filecriteriatolookfor This can be the name of the
file, type of file e.g. directory, modification time, size,
permissions or almost anything else that describes a
file. You may also specify multiple criteria to fine
tune the search.

You'll want to keep an eye on your disk drives,
because when they start to get full you will have
problems. The simple
df (MS = net share, not really but the closest I could
find) command will show you your disk free space.

To display the contents of a file from beginning to
end, we have the cat command which we have
already met and, just as tail is complemented with
head, the cat command has its own counterpart tac,
which displays the lines of text in the file in reverse
order, last line first. Why on earth would you want to
do that? Well, many Linux commands produce log
files documenting their experiences and output.
Using the tac command allows us to see the latest
output from the command first.

To search your home directory and directories
immediately below but no further for files that end in
.jpg you can issue the command
To also find files with the .JPG extension use the
case insensitive search predicate iname in place of
name.
find ~/Documents/ mtime 0 will list all files that
have been modified in the last 24 hours.
find / size +1000M shows all files on the system
larger than 1000MB (1GB) a minus sign would show
all files under 1000MB – that's a lot of files! If you try
and execute this without root privileges you will
generate a lot of “permission denied” type error
messages as the command attempts to enter
directories to which you have no access granted.
You can get around this by using a technique,
discussed in the second of the articles, called
redirection.

PCLinuxOS Magazine

Similarly, if you want see only part of the beginning
of a file, use the command head.
dmesg | head n 20

Whattomatch This can be the filename or a part of
it including wild cards such as * (also regular
expressions for those that understand such things).
It can be the time since modification or access and it
can be a minimum or maximum file size.

find ~ maxdepth 2 name “*.jpg”

dmesg | tail n 15

To discover just how that space is being used, issue
the following disk usage command
du with no arguments. It will show what is being
used by the files and directories in the current
directory. Use du Documents/ to get results from
that directory. Add the option s to get only a
summary. If you try it with the root directory du / then
you will get a lot of errors as with the find command.
If you press the escape key whilst booting, you will
see a lot of information scrolling past as the kernel
sets things up. This output continues after boot up
as the kernel starts and stops things or has anything
to say that it considers important. This information
can be useful when things are not working as they
should, perhaps a usb drive is not being recognized.
The dmesg command will print out this information
but it prints out far more than you need and you will
probably only be interested in the last few lines.

System administration
To control ownership of a file, we have the chown
command which allows us to change both user and
group ownership of a file. The R option allows you
to recurse down into directories, changing the
ownership of all files therein.
chown user:group file
chown user file
chown :group file
You may specify just the user, both user and group
separated by a colon or just the group which must
then be preceded by a colon.
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An ordinary user can change the group ownership of
a file to any group of which they are a member, but
root or superuser privileges are required to change
user or global group ownership.

the password will be changed. With root
permissions, you may also specify a username for
whom you want to change the password (or
suspend to prevent the user logging in).

Some distributions use the sudo command to grant
temporary root powers. For security reasons
PCLinuxOS does not. This distribution uses the su
command (switch user).

In order to correctly power off or reboot a system
from the command line, root has the command
shutdown (MS = reboot).

The su command defaults to switching to the root
user unless another user name is specified. You can
switch to assume the identity of any user whose
password you know (which is why you should keep
your password secret.)
su guest would prompt for the password of the user
guest, and then allow you to do what you will with
guest’s files and directories, including deleting them!
For this reason su should be used with caution. As
user root you have the power to do anything with
any or all files on the system!
There are a couple of options to su that you should
be aware of.
With no options su grants you the powers of root but
leaves you where you were in the file system.
The command su l gives you a login shell. It is just
as if you had logged in as root and the squiggle after
the prompt now means the directory /root, not your
own home directory. To relinquish the powers of root
and return to being a mere mortal, type controld or
the command exit (MS = exit).
The command su c command will prompt you for
the root password, execute the command as root
and then return you your normal user status.
To change your password use the passwd
command. It will prompt you for the current
password, the new password and then confirmation
of the new password. If these last two match, then
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On a multiuser system, you would want to warn
users and give them time to save their work before
performing such an operation, and this is what this
command does. The r option tells the command to
reboot the sysyem and the h command tells it to
halt the system. There is a mandatory time option
which for a single user system may be now. If you
don't specify a warning message, then a default
message is issued.
shutdown r
immediately.

now

Reboot

the

ps (MS = tasklist). There are many options to this
command, but ps u will list processes owned by
you. If that doesn't show the process, then ps ax
usually will, but the output will be quite lengthy. Look
for the number under the PID column.
To terminate the process we use the command kill
PID. Sometimes a process will resist this attempt
and then we have to use the much stronger kill 9
PID. Look at the following example.

computer

shutdown h 18:30 “The system will be halted at
6:30pm for routine maintenance”
shutdown c Abort a scheduled shutdown.
Every time that you execute a command or run an
application, the kernel will start a separate process
for that command. Often that command will generate
many subprocesses. Occasionally a process may
'hang' or go into an infinite loop, refusing to respond
to your efforts to terminate it. Here we need to know
how the system refers to that process, so we have to
find its process id. For this, we have the command

Firefox is running in process 13111 until the kill
command is issued which terminates the application.
Another command that allows you to work with
processes is top (MS = mem). Here Firefox has the
process id 13928.
To terminate the process press k and you will be
prompted PID to kill:
enter 13928 and you will then be prompted
kill PID 13928 with signal [15]: Type y to end the
process. The top command can be quite complex at
times but there is an alternative which is much more
user friendly. It is called htop and is not installed by
default but is available for installation from the
repositories using the package manager Synaptic. I
would recommend installing htop.
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Unlike Windows, Linux does not use drive letters like
c:. Each partition is mounted at a particular place
within the file system and the files on the device are
then accessed from that place. Usually all of this is
handled seamlessly by the text file /etc/fstab, and
you don't need to bother about it. If you insert a usb
drive, then this is unlikely to be listed in fstab.
Modern systems usually detect this and
automatically mount (or offer to mount) the device.
The command line allows you to have more control
over this with two commands named mount and
umount (no, that is not a typo. The command is
umount not unmount: I told you Linux users were
lazy typists.). To use the command you need to
know how the kernel refers to the device. This is
usually with a device name like /dev/sda1 which is
the first partition (1) on the first hard drive (a). if you
insert a usb thumb drive and then issue the
command dmesg | tail –n 20 then you will see
some output like this (I added the underlining).
usb 52.1: ep 0x81  rounding interval
to 32768 microframes, ep desc says 0
microframes
usb 52.1: ep 0x2  rounding interval
to 32768 microframes, ep desc says 0
microframes
Initializing
USB
Mass
Storage
driver...
scsi8 : usbstorage 52.1:1.0
usbcore:
registered
new
interface
driver usbstorage
USB Mass Storage support registered.
usbcore:
registered
new
interface
driver uas
scsi 8:0:0:0: DirectAccess Kingston
DataTraveler G3 PMAP PQ: 0 ANSI: 0 CCS
sd 8:0:0:0: Attached scsi generic sg4
type 0
sd 8:0:0:0: [sdd] 7653312 512byte
logical blocks: (3.91 GB/3.64 GiB)
sd 8:0:0:0: [sdd] Write Protect is off
sd 8:0:0:0: [sdd] Mode Sense: 23 00 00
00
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sd 8:0:0:0: [sdd] No Caching mode page
present
sd
8:0:0:0:
[sdd]
Assuming
drive
cache: write through
sd 8:0:0:0: [sdd] No Caching mode page
present
sd
8:0:0:0:
[sdd]
Assuming
drive
cache: write through
sdd: sdd1
sd 8:0:0:0: [sdd] No Caching mode page
present
sd
8:0:0:0:
[sdd]
Assuming
drive
cache: write through
sd
8:0:0:0:
[sdd]
Attached
SCSI
removable disk
Line 8 (underlined) shows that the system has found
my thumb drive, a Kingston Data Traveller. Now look
at line 17 (also underlined). This tells me that the
kernel has named this device /dev/sdd and there is
one partition on it named /dev/sdd1. This is the
information that I need.
I need to mount this device somewhere so that I can
access it and the system has a special place for
removable devices  /mnt. If I mount it there then I
have nowhere to mount further devices so I need to
create a directory inside (or under) this directory. To
do this I need root privileges.
su (enter the root password)
mkdir /mnt/usb1 and then, finally the mount
command
mount /dev/sdd1 /mnt/usb1 read this as “mount
this_device in this_place”.
ls /mnt/usb1 would list the contents of the thumb
drive to the screen.
The Linux system writes data asynchronously. This
means that the data is not written immediately to the
device and so it is very important the device is
correctly removed or data loss may occur. This is

done with the umount command which
synchronizes data writes before unmounting the
device.
Umount /dev/sdd1 The device may now be safely
removed.
Controlling command output
When you receive some output from a command it
invariably is not in the order that you want it. To sort
it into the required order we use a command called,
naturally, sort (MS = sort)
There are many options for sort to produce data
sorted alphabetically, numerically, reversed, by date
etc. This is is one of many Linux tools known as a
filter. Data is passed to a filter and the output is the
altered data. This is one of the basics of command
line operation and part of the real power of Linux.
The usual way of using a filter is to separate the
command producing the data from the filter with the
vertical bar character known as a pipe.
The tr command, while not used very often, is
designed to translate one set of characters into
another. One use might be to translate lower case to
upper case. The command is used as a filter and I
find the s option most useful. This option squeezes
out multiple repeats of a listed character and
replaces them with a single instance of that
character. For example cat textfile | tr s “ “.
The cat command sends the file to the tr command
which then removes all multiple spaces. Use “\t” to
remove extraneous tabs. This doesn't actually alter
the original file, only the output from the command is
affected as it passes through the filter.
Some commands produce so much output that it is
difficult to find the information that you want. You
could pipe the output to a pager such as less (MS =
more), but you would still have to search through a
lot of irrelevant stuff. Linux has a command named
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grep (the name is actually an acronym but that's
irrelevant here) that we can use to solve this little
problem.
The grep (MS = find) command is designed to
search inside a file for text that matches a pattern.
grep “Once upon a time” ~/Documents/* would
search all of the files in your Documents directory for
the given phrase.
If we pass the output of a command to grep then it
will search that output for the expression.
ps ax | grep firefox will make it a lot easier to find
the process id of the unresponsive firefox.
The v option inverts the match and displays lines
that do not match.
A lot of Linux commands produce columns of
information separated by spaces, tabs, commas or
colons. Most of this data you will not be interested
in, so wouldn't be nice if you could cut out and
display only the relevant data? Well you can with the
cut command, which sees the data as strings or
fields of characters split by a separating character or
delimiter (tab by default). The output from the df
command with no options would look something like
this:
Filesystem
/dev/sda1
/dev/sda5
/dev/sdb6
none
/dev/sdd1

Size
26G
352G
391G
7.8G
3.7G

Used
8.4G
149G
247G
124M
613M

Avail Use% Mounted on
16G
35%
/
186G 45% /home
124G 67% /share
7.7G
2% /tmp
3.1G 17% /mnt/usb

These fields appear to be delimited with a tab
character, which is the default for the cut command.
If we want only the Filesystem and Mounted
columns, then we can ask cut for fields 1 and 6
using the f option to specify the fields.
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ps | cut f 1,6 Unfortunately this will not work in this
case as the delimiter is not a tab as we thought, but
the output has been prettied up by padding with
empty spaces. We can use the tr s command to
squeeze out the extra spaces and then use the f
option with cut to set the delimiter.
df | tr s ' ' | cut d' ' f 1,6
Filesystem
/dev/sda1
/dev/sda5
/dev/sdb6
none
/dev/sdd1

Mounted
/
/home
/share
/tmp
/mnt/usb

Miscellaneous commands
Sometimes the terminal screen can get cluttered
and distract from the job at hand.
Issue the clear command and you can start over
with a blank page. (MS = cls)
No list of terminal commands would be complete
without a text editor. Text files are so central to the
operation of Linux that there are hundreds of
commands to manipulate them. This text has to be
created and often edited. There are many text
editors available in Linux including the extremely
powerful but dauntingly unfriendly vi. PCLinuxOS
comes with a very nice, simple command line text
editor called nano (MS = edit). If not already
installed in your version then it is worth opening
Synaptic and adding it to the system.
Type nano filename and if the file exists, it will be
loaded. If not, then a blank file will be opened ready
to save when you have added some content. At the
bottom of the screen is a menu, ^ means hold down
the control key and then press the letter following it
to perform the associated operation. Controlg will
get you some basic help.

If you want a hard copy of a file, and you have a
printer installed, then lp (MS = print) myfile will print
it out. It's that simple.
Most Windows users are familiar with the
commercial file compression programs Winzip or
pkzip. The Linux command line equivalent is gzip
gzip myfile compresses a file with the default
options and the default file extension .gz
gzip –d myfile.gz decompresses a file with the
default options
gzip also accepts a number between 1 and 9 as an
option, 1 for faster compression, 9 for more
aggressive compression.
tar is a command from the past but it is still very
useful. The letters tar are an acronym for tape
archive. When files were traditionally written to
magnetic tape for backup, collections of files were
bundled into an archive for later retrieval. This is still
useful today although the files are more usually
'tarred' and compressed then the 'tarball' is
transferred to another file system or over the
internet.
The default file extension (to aid humans) is .tar. The
tar command can now automatically compress files
using several compression techniques. This is
usually denoted by a file extension of .tar.gz or
similar.
tar cf file1 file2 creates a tarball of files file1, file2.
tar czf docs.tar.gz ~/Documents/ creates a zipped
file of all the files in your Documents directory.
tar tf docs.tar.gz lists the files in the archive.
tar xzf docs.tar.gz extracts the files from the
archive.
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There are so many options to this command that you
really do need to either read the documentation or
restrict your usage to these simple examples, which
will probably be all that you ever need.

Want To Help?

Would you like to help with the PCLinuxOS
Magazine? Opportunities abound. So get
involved!
You can write articles, help edit articles, serve
as a "technical advisor" to insure articles are
correct, create artwork, or help with the
magazine's layout.

Screenshot Showcase

Join us on our Google Group mailing list.

Posted by francesco bat, May 16, 2013, running KDE.
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Windows Migration: Resources & Summary
by Paul Arnote (parnote)
Now that you’ve taken the plunge and switched from
a costly, limiting proprietary operating system to the
free and open Linux operating system, you’ve
earned the right to give yourself a huge pat on the
back. You’ve taken the first steps in unleashing the
full capabilities of your computer. You’ve liberated
yourself from costly operating system “upgrades”
and even costlier software packages. You’ve freed
yourself from the scourge of viruses, malware,
spyware and crapware that infests Windows. You’ve
embarked on a journey of freedom.

transfer easily and readily to your Linux skill set. But
it’s also important to keep in mind that while there
are similarities, Windows is not Linux, and Linux is
not Windows. They are different from one another,
which is a good thing. If you wanted things to be the
same, you’d still be using Windows. Linux users
fervently believe that the Linux way of doing things is
better.
Because Linux and Windows are different, there will
be a learning curve while you learn those
differences, along with the different ways of doing
things under Linux. To help you out, I’ve compiled a
list of reference resources to assist you along the

way. This list, however, is not an exhaustive list.
There are many, many more resources available to
you than I could ever possibly list here. If you don’t
find what you’re looking for in the list below, don’t
hesitate to perform an internet search. Chances are
high that you’ll find a solution.
Forums
PCLinuxOS Forum: for any PCLinuxOS user, the
first place to go for help and guidance really should
be the PCLinuxOS forum. There, you can talk with
and pick the brains of others who are also using

You can say goodbye to the infamous “blue screen
of death” that plagues Windows users. Back when I
was a Windows user, I could barely go two days
without seeing Windows crash and display that
!#$*^&@ blue screen. In exchange, you can say
hello to a higher level of stability and more security
than any Windows user could ever hope to
experience. Some Linux users go years without
rebooting their computer, and their computers
remain running with the same level of stability and
reliability as the day they were first booted. When I
was a Windows user, if I didn’t reboot Windows
every day, I would be guaranteed of a visit from that
infamous blue screen of death, a.k.a. the BSOD.
Linux gives you a flexibility and freedom to configure
and use your computer the way you want. You’re not
restricted to using and configuring your computer the
way some corporate entity that’s only concerned
about profits dictates that you should use or
configure your computer.
Without a doubt, the computer skills you developed
while using Windows – using a mouse and
keyboard, opening and saving files, etc. – will
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PCLinuxOS. Don’t worry … those who frequent the
forum are generally a friendly and helpful bunch.
Just be sure to acclimate yourself to the forum rules
by reading the “sticky” posts in each section.
LinuxQuestions.org: the LinuxQuestions.org forum
is a very friendly place where you can talk with Linux
users from virtually every and any Linux distro. While
this forum is more focused on Linux in general, there
are also sections of the forum that cater to specific
Linux distros.
LinuxForum.com: similar to LinuxQuestions.org,
the LinuxForum.com forum is more broadly focused
on Linux in general. There is a section of the forum
that caters to specific Linux distros.

Magazines

For PCLinuxOS users, the first place to look for
PCLinuxOS specific information would be this very
magazine – The PCLinuxOS Magazine. On the
magazine’s website are every back issue of the
magazine ever produced, plus every special edition,
and it's all free of charge.
Here is a list of other magazines aimed at Linux
users and free software:

IRC: Internet Relay Chat
Internet Relay Chat has been around … well,
forever. IRC was a thriving place over 25 years ago
when I first discovered it. Just a quick search of IRC
channels for “linux” specific topics listed over 1100
channels, all on the FreeNode IRC network. As a
PCLinuxOS user, there are also specific IRC
channels for your use. First, there is the
#PCLinuxOS channel, which is for general chitchat
about PCLinuxOS and other topics of interest. If you
have a support question, head on over to
#PCLinuxOSSupport. If you want to chitchat with
the staff of The PCLinuxOS magazine, drop into the
#pclosmag channel and introduce yourself.
Don’t be shy. Feel free to ask your question. If you
don’t get an answer right away, just hang out for a
while. Chances are good (especially in the specific
support channel) that someone will stumble upon
your question and offer to help. Even though there
may be lots of people listed in the channel, they may
be away from their computers. However, they will
attempt to answer your question once they discover
your request for help – provided you are still around.

PCLinuxOS Magazine

Free Software Magazine: aimed at covering Linux
and the free software movement. An online ezine
magazine.

Full Circle Magazine: despite targeting Ubuntu
users, you can also find some good, general interest
Linux articles within its pages. Download as a PDF.

Linux Format: the best selling Linux magazine in the
UK, you’ll find all sorts of useful information within its
pages. This magazine is available for a cost with a

subscription. Even if you don’t subscribe, there is
some content that’s available for free. Also keep
your eyes open for free, complimentary issues and
special editions.

Linux Gazette: Although no longer published on a
consistent basis (the last issue on the web site is
January 2013), new content is being added
periodically, even if irregularly. Linux Gazette was
started in 1995. You are likely to find some valuable
information by browsing through the magazine’s
archived issues.

Linux Journal: the oldest magazine devoted
specifically to Linux, it was started in 1994. In 2011,
the magazine ceased production of a print version,
and now publishes a monthly magazine available in
digital download formats (similar to how The
PCLinuxOS Magazine publishes). It’s available by
subscription for $29.95 (U.S. dollars) per month.
However, don’t let the paid subscription status deter
you. There is a considerable amount of “free” or
complimentary content available on their website.

Linux Magazine: an onlineonly magazine by
subscription, there is a considerable amount of
content that is available for free.
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Windows Migration: Resources & Summary
Those are the major magazines that target users of
Linux. There are others, but they are either very
narrow in their appeal, or they have ceased
publication.
Websites
Linux.com: this is THE authoratitive voice of Linux,
since this is the home page of The Linux
Foundation.
Phoronix: this website specializes in hardware and
software reviews, as well as an excellent source of
Linux news.
Tuxmachines: a good source for Linux news, run by
Susan Linton.
Distrowatch: a site that reviews Linux distros and
ranks them by popularity.
LWN.net: an excellent news site for all things related
to Linux.
Going Linux: a website specializing in information
that’s useful for computer users transitioning from
Windows to Linux. Of particular interest may be their
resource page.
IBM developerWorks: IBM is one of the many
companies that is a regular contributor to Linux. In
fact, they are one of the largest companies that
contribute to Linux. This particular page is dedicated
to teaching basic Linux concepts to users new to
Linux.
Linux.org: a user supported community website
whose mission is to promote Linux through
education. The content of this website is designed to
be interacted with by the Linux Community.
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Books
O’Reilly Publishing: publishes all kinds of computer
manuals, books and educational materials …
including those covering topics of interest to Linux
users. Want to learn the command line? Want to
learn how to program? Want to learn bash scripting?
Want to learn more about Linux networking? All of
these topics – and more – are covered in O’Reilly’s
offerings.
User Groups
Perhaps one of the most overlooked resources are
local Linux User Groups. They usually meet
regularly in space that’s donated by either schools,
libraries or computer shops. You can perform an
Internet search for user groups in your area, or you
can ask around at your local computer shops for
contact information. You’ll have the chance to meet
with other Linux users from your area, usually
without a preference for any one particular distro. As
you become more proficient, you can give
presentations about different aspects of your favorite
Linux distro – which will (hopefully) be PCLinuxOS.
Summary
Congratulate yourself on making the switch from the
costly, proprietary world of Windows to the free,
open world of Linux. You’ve taken a huge step in
breaking the chains that have held your and your
computer’s capabilities down. There is so much
more in this world than “just Windows.” We, your
fellow Linux users, think that there is something
much better than Windows, and we think that we
have found that with Linux.
It is our hope here at The PCLinuxOS Magazine that
we have provided at least some assistance in
making your transition to Linux easier and a lot more
enjoyable. Good luck!

Support PCLinuxOS! Get Your Official

PCLinuxOS

Merchandise Today!
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Does your computer run slow?
Are you tired of all the "Blue Screens
of Death" computer crashes?

Are viruses,
adware, malware &
spyware slowing
you down?
Get your PC back
to good health
TODAY!
Get
Posted by AGust, May 1, 2013, running e17.
Download your copy today! FREE!
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ms_meme's Nook: The Penguin Story

There is a story the penguins know is true
That when you're booting up with Linux
The net belongs to you
An OS story that's told by a gnu
That if you're booting up with Linux
You'll have a real breakthrough

How your mouse is waiting just to feel that special touch
All your files and folders will like it very much
I thank the penguins for the story they recite
And I will always boot up Linux 'twill be my delight
MP3
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PCLinuxOS Recipe Corner

Chicken Quesadillas
Ingredients:
1/2 lb. Chicken,chopped very small
1/3 c. Sour cream (can be lowfat)
1/3 c. Salsa
1 c. Shredded cheese, any type, I prefer cheddar
12 Small soft tortillas
1/2 tsp. Garlic salt
Pepper to taste
1 tsp. Chili powder
1 tsp. Paprika
1/2 tsp. Cumin
Cooking Instructions:
1. Saute chicken with seasonings.
2. In medium bowl, combine chicken, sour cream,
salsa and cheese.
3. Heat frying pan to medium.
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4. Sandwich the mixture between two tortillas at a
time. Place enough mixture so there is about an inch
between the mixture and the edge of the tortilla.

5. Heat each quesadilla in the pan, and flip when the
bottom is lightly browned. Serve with salsa and sour
cream to dip. Enjoy!
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World Environment Day: June 5
United Nations Environment Programme
Press Release
The theme for this year’s World Environment Day
celebrations is Think.Eat.Save.
Think.Eat.Save is an antifood waste and food loss
campaign that encourages you to reduce your
foodprint. According to the UN Food and Agriculture
Organization (FAO), every year 1.3 billion tonnes of
food is wasted. This is equivalent to the same
amount produced in the whole of subSaharan
Africa. At the same time, 1 in every 7 people in the
world go to bed hungry and more than 20,000
children under the age of 5 die daily from hunger.
Given this enormous imbalance in lifestyles and the
resultant devastating effects on the environment, this
year’s theme – Think.Eat.Save – encourages you to
become more aware of the environmental impact of
the food choices you make and empowers you to
make informed decisions.
While the planet is struggling to provide us with
enough resources to sustain its 7 billion people
(growing to 9 billion by 2050), FAO estimates that a
third of global food production is either wasted or
lost. Food waste is an enormous drain on natural
resources and a contributor to negative
environmental impacts.
This year’s campaign rallies you to take action from
your home and then witness the power of collective
decisions you and others have made to reduce food
waste, save money, minimise the environmental
impact of food production and force food production
processes to become more efficient.
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If food is wasted, it means that all the resources and
inputs used in the production of all the food are also
lost. For example, it takes about 1,000 litres of water
to produce 1 litre of milk and about 16,000 litres
goes into a cow’s food to make a hamburger. The
resulting greenhouse gas emissions from the cows
themselves, and throughout the food supply chain,
all end up in vain when we waste food.
In fact, the global food production occupies 25% of
all habitable land and is responsible for 70% of fresh
water consumption, 80% of deforestation, and 30%
of greenhouse gas emissions. It is the largest single
driver of biodiversity loss and landuse change.
Making informed decision therefore means, for
example, that you purposefully select foods that
have less of an environmental impact, such as
organic foods that do not use chemicals in the

production process. Choosing to buy locally can also
mean that foods are not flown halfway across the
world and therefore limit emissions.
So think before you eat and help save our
environment! Find out more information at:
http://www.unep.org/wed.

Want to keep up on the latest that's
going on with PCLinuxOS?
Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos
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Xfce Power User Tips, Tricks & Tweaks:
Working With Documents

by Paul Arnote (parnote)

Next, select an icon for your new custom action.
Under the “Appearance Conditions” tab, leave the
“File Pattern” set to *, and place a checkmark in front
of “Text files.”

At some point, everyone using a computer has had
to deal with documents of one kind or another. Most
of us have exchanged word processing files or
spreadsheets. Most of us have either downloaded,
viewed or created PDF files. All of us have dealt with
plain text files of one kind or another.

Now, when you right click on a plain text file, you can
select “Print Text File” from Thunar’s rightclick
context menu. When you do, you’ll see the familiar
“Print” dialog box, allowing you to select which
printer to use.

With this month’s Xfce Power User Tips, Tricks &
Tweaks article, we’ll look at ways to simplify working
with various document files.

Preview Text Files
Many times, you don’t necessarily want to print a
text file. You just want to browse its contents. Since I
subscribe to the K.I.S.S. principle, I have a practice
of keeping phone number lists and address lists in
simple, plain text files. Lots of them. It’s a method
that I’ve used for years, and one that has always
worked exceptionally well for me.

Printing Text Files
Invariably, at some point, you’ll want to print out a
plain text file. Normally, you could just open it up in a
simple text editor, then print it out. But, with this
Thunar Custom Action, we can actually skip that
step, and print it right from Thunar itself.

If I just want to look up someones address or
telephone number, or just take a look at the contents
of any other plain text file, I don’t necessarily even
have to open it up in a text editor. This Thunar
Custom Action allows me to preview the first part of
a text file in a dialog box on my screen, quickly and
easily.

Select “Configure Custom Actions...” from the
Thunar “Edit” menu. On the first line, provide a name
for your new Thunar Custom Action. I entered “Print
Text File” as its name. On the second line, enter a
description. Keeping it simple, I entered “Print text
file” as its description. On the third line, enter the
following command:

In configuring the Thunar Custom Action, provide a
name and description. I entered “Preview Text File”
for the name, and “Preview the selected text file” for
the description. On the third line, enter the following
command:

yad print filename=%f type=TEXT add
preview
The type=TEXT flag tells yad to print the specified
file (filename=%f) as a text file. If you used the 
type=IMAGE flag, you could easily set up a similar
custom action to print out image files. The add
preview flag adds the “Print Preview” button to the
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Print dialog box. If you choose to omit this flag, only
the “Print” and “Cancel” buttons will be displayed.

head n 100 %f | zenity textinfo width=450 
height=400 title="Text Preview"
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You can change how many lines you want to be
displayed simply by changing the number. For
example, if you enter 20 (as n 20), only the first 20
lines are displayed. Any text files less than the
specified number of lines in length will simply be
displayed in their entirety. The output from the head
command is then piped into a Zenity text dialog box,
with a width of 450 pixels, a height of 400 pixels,
named “Text Preview.”
Select an icon for your new custom action. Under
the “Appearance Conditions” tab, leave the “File
Pattern” set to *, and insure that only “Text Files” has
a checkmark in front of it.
Now, whenever you right click on a text file and
select “Preview Text File” from Thunar’s context
menu, your text file is displayed similarly to the
example above. You can scroll through the contents,
and when you are finished, just hit the Enter key (or
click your mouse on the “Close” button).
The command uses the head command to display
the first 100 (n 100) lines of the specified file (%f).

Print Office Files
Besides text files, another common item printed out
are office files. These are files commonly produced
by “office suite” software, and includes word
processing files, spreadsheets, database reports
and any other type of common office files. Of course,
you could always open the file in LibreOffice, but
that’s no longer necessary with this Thunar Custom
Action. Why wait for LibreOffice to load if all you
want to do is print out a document? All that is
necessary is that LibreOffice must be able to open
and render the file format.
Create a new Thunar Custom Action, and provide a
name and description for it. I entered “Print Office
File” for the name, and “Directly print files
recognized by LibreOffice” as the description. Enter
the following command on the “Command” line:
libreoffice3.6 invisible p %f
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First, the libreofficeXX command must match the
version of LibreOffice that you have installed. On this
particular computer, I’ve not updated to LibreOffice
4.x yet, preferring to remain with LibreOffice 3.6.
Once I do update to the most current version of
LibreOffice, I will need to change my custom action
commands to reflect the appropriate version of
LibreOffice that is installed on my computer, due to
the naming conventions used for the LibreOffice
files.
The invisible flag tells libreoffice3.6 to start without
displaying the typical user interface or startup splash
screens. The p flag tells libreoffice3.6 that we
merely want to print the designated file (%f) on the
system’s default printer (so be sure your default
printer is set appropriately).
Now, choose an icon for your new custom action.
Under the “Appearance Conditions” tab, place the
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following into the “File Pattern” field, and place a
checkmark in front of “Other files.”

rightclick context menu. The resulting PDF will be
written to the same directory as your original file.

*.doc;*.docx;*.odt;*.odp;*.pps;*.ppt;*.xls;*.xlsx;*.
ods;*.pptx;*.pdf

Convert To OpenDocument Text Format

When you right click on one of the above file
formats, you will be able to choose “Print Office File”
from Thunar’s right click context menu and send that
file directly to your default printer, without ever
having to open LibreOffice.

Besides converting to PDF files, you can also
convert from any other document format that
LibreOffice can read into a native LibreOffice
OpenDocument format – all without having to open
the document in LibreOffice. For this Thunar Custom
Action, I’ll use the example of converting from *.doc
and *.docx files to *.odt files, but you can easily
create separate Thunar Custom Actions for
converting from *.xls and *.xlsx files to *.ods files and
so on.

Convert File To PDF
If you’ve ever needed to share a document with
others, the difficulty becomes whether or not the
receiving party has the appropriate file viewer. For a
long time, no one but Microsoft Office users could
open or view *.docx files – at least, until someone
hacked the format. Meanwhile, Microsoft users might
have some difficulty opening LibreOffice or
OpenOffice files. Fortunately, there’s an easy
solution: just convert the file to a PDF file, which
nearly everyone on any modern operating system
can read. With this Thunar Custom Action, it’s easier
than 123.
The added benefit of distributing your document as a
PDF is that it’s not easily altered by the average Joe
computer user. Thus, your document is typically
viewed in the manner and formatting that you
intended, and you don’t have to worry that your
document will be altered. The PDF format has
gained a status that is pretty much universally
accepted (despite its Adobe roots).
Create your new custom action. Give it a name and
a description, respectively, on the first and second
lines. I named mine “Convert To PDF” and provided
“Convert the selected file to PDF” as the description.
On the third line, enter the following as the
command:
libreoffice3.6 invisible convertto pdf %f
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Remember that the number part of the libreofficeXX
command must match the version of LibreOffice that
you are running (same as in our last Thunar Custom
Action). The  invisible flag tells LibreOffice to not
open the GUI to perform the specified action. The
convertto command tells it what format to convert
to (pdf), and the %f is the file to perform the
conversion to.
Select an icon for your new custom action. I used
one of the Adobe PDF icons that wasn’t already in
use on my system. Then, enter the following for the
“File Pattern” field:
*.doc;*.docx;*.odt;*.odp;*.pps;*.ppt;*.xls;*.xlsx;*.
ods;*.pptx;*.txt
Place a checkmark in front of both the “Text files”
and “Other files” for file types. Now, whenever you
right click on any of the file formats above, you’ll be
able to choose “Convert To PDF” from Thunar’s

Create your new Thunar Custom Action, and provide
a name and description on the first two lines,
respectively. I gave mine the name of “Convert To
OpenDocument Text Format,” and “Convert the
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selected file to an ODT file” as the description. On
the third line, enter the following command:
libreoffice3.6 invisible convertto odt %f
Remember to use the same number in the
libreofficeXX command as the version of LibreOffice
you have installed. Notice that the command is
almost exactly like the previous command (where
we converted the selected file to a PDF file), except
that we now have selected the OpenDocument *.odt
file as the format that we want to convert to.
Choose an icon for your new custom action. Under
the “Appearance Conditions” tab, enter *.doc,*.docx
as the “File Pattern” to match, and place a
checkmark in front of “Other files.”

Connect

All your
PCLinuxOS
connections in one
convenient location!

Screenshot
Screenshot Showcase
Showcase

Now,
whenever
you
select
“Convert To
OpenDocument Text Format” from your Thunar’s
right click context menu, your selected file will be
converted to an OpenDocument *.odt file. Just to be
sure, I would recommend opening the new *.odt file
to make sure that the conversion went well.
Also, don’t forget that you can also make separate
Thunar Custom Actions to convert from Excel
spreadsheet formats (*.xls and *.xlsx) to the
OpenDocument *.ods spreadsheet format. Since I
don’t deal with spreadsheets all that much, I didn’t
make the effort. However, I do know that there are
some users out there that use spreadsheets a lot,
and this variation on the Thunar Custom Action
would be useful for them.
Summary
As you can see, there are quite a few ways to deal
with document files, without ever having to really
open the files. Whether it’s just a plain text file, or if
it’s a complex word processing file, you can easily
work with and manipulate the files right from Thunar,
quickly and effectively.
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Posted by bozzoh, May 9, 2013, running IceWM.
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PCLinuxOS Puzzled Partitions

Tux Scrappler

TUX SCRAPPLER RULES:
Follow the rules of Scrabble®. You can view
them here. You have seven (7) letter tiles
with which to make as long of a word as
you possibly can. Words are based on the
English language. NonEnglish language
words are NOT allowed.
Red letters are scored double points.
Green letters are scored triple points.
Add up the score of all the letters that you
used. Unused letters are not scored. For
red or green letters, apply the multiplier
when tallying up your score. Next, apply
any additional scoring multipliers, such as
double or triple word score.
An additional 50 points is added for using
all seven (7) of your tiles in a set to make
your word. You will not necessarily be able
to use all seven (7) of the letters in your set
to form a “legal” word.

When you start a game of Sudoku, some blocks will be prefilled for you. You cannot
change these numbers in the course of the game.
Each column must contain all of the numbers 1 through 9 and no two numbers in the
same column of a Sudoku puzzle can be the same.
Each row must contain all of the numbers 1 through 9 and no two numbers in the same
row of a Sudoku puzzle can be the same.
Each block must contain all of the numbers 1 through 9 and no two numbers in the
same block of a Sudoku puzzle can be the same.
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0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

Download Puzzle Solutions Here!

Sudoku Rules: There is only one valid solution to each Sudoku puzzle. The only way
the puzzle can be considered solved correctly is when all 81 boxes contain numbers
and the other Sudoku rules have been followed.

In case you are having difficulty seeing the
point value on the letter tiles, here is list of
how they are scored:

Optionally, a time limit of 60 minutes should
apply to the game, averaging to 12 minutes
per letter tile set.
Have fun! It's only a game!

225 points possible. Average mark is 156 points.
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PCLinuxOS Crossword Puzzle: June 2013
Internet Applications

1.

Popular IRC Client

3.

Popular alternative web browser

2.
4.
5.
6.
7.
8.
9.

10.
11.

12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.

Browser from the Mozilla Foundation
Official GNOME web browser
Mac OS browser

Gtk+ lightweight browser

Popular FTP and SSH client

Open source version of browser from Google
Popular Mozilla based email client
One of the popular early browsers
Official browser of Xfce

Textbased Linux/Unix browser

Browser suite based on Mozilla
Gtk+ BitTorrent software

Popular browser from Google

Mozilla based WYSIWYG HTML editor
Webkit/Qt based alternative browser
Popular instant messaging client
KDE official browser

Popular GNOME email client

Minimalistic web browser particularly intended for
older or slower computers and embedded
systems
Popular VoIP software

One of the most popular cloud storage services

Download Puzzle Solutions Here!
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Download Puzzle Solutions Here!

PCLinuxOS Internet Apps Word Search
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LinPC.us

Screenshot
Screenshot Showcase
Showcase

Available in the following desktops:
KDE

LXDE

Openbox

Xfce

Gnome

Enlightenment e17
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Posted by Aleph, May 5, 2013, running LXDE.
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Game Zone: Tiny & Big
by daiashi

Features
Unique Handdrawn Look – all handcrafted
textures, primo Hatch Shading, and dynamic Sound
Words put you right into a graphic novel!
Creative Jump ‘n’ Slice Gameplay – use grappling
rope, rocket science and laser surgery to slice the
whole world, overcoming all obstacles in your very
own way. Enjoy unlimited slicing freedom and unique
sandbox gameplay!
Better than Life Physics – experience believable
physics in a completely destructible, immersive
environment that has been built to be cleaved into
beautiful, multicoresimulated pieces of art!

About The Game
The Story
Tiny & Big is set in a land where common physics
apply, but everything else looks different. You are
Tiny, a technophile guy with a ray cutter, a gripping
device and a fine attitude towards the world. But
now your nemesis, Big, stole the only heritage your
grandpa left you: a nice pair of white, fine rib
underpants! He‘s surely up to no good: why else
would he take them to that forsaken desert… where
no one goes! So, load up that selfmade raygun and
rope device (snitched from the local hardware store)
and take your annoying and jabbering backpack to
accompany you. It‘s always been of good use to
your gramps. Besides, the robot taxi to the desert is
waiting! Run, jump, drag, shove and laser your way
through the ultimately ancient scenery, and gain
back those underpants!
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Characterdriven Story Line – follow Tiny into a
weird and humorous story drenched in peculiarity:
get back Grandpa’s underpants, by all means
necessary. Defeat Big, your old arch enemy, in the
process!
Buckets full of Indie Music – collect more than 15
songs from hardly known but genuine Indie bands.
Discover new songs from the underground, and
show off to your friends!
System requirements:
Core2duo / Athlon X2 with at least 2.4 GHz
GeForce 8800 series / Radeon 2900 series or better.

About The Company
Black Pants Game Studio is an independent game
studio rooted in Kassel. We are a team of three
programmers, two animators and one comic artist.
We are passionate about playing and developing
games with new and innovative mechanics and a
handcrafted and oneofakind look.
To manufacture Tiny & Big, we are using our own
engine, the Scape Engine, which is in development
since 2002 and constantly extended and improved.
And about the folks who put it all together

Christian Niemand started programming in 2000
during his education as an industrial electronic. He
worked as a scientific and project director at the
University of Kassel. Christian is a passionate
videogamer since childhood. In addition to
videogames he likes to play the Blues piano, ping
pong, squash and other sports. At Black Pants
Game Studio, he‘s responsible for engine
programming and marketing. For any inquiries, he’s
the one to contact mail: chris(a)tinyandbig.com

Windows: XP or higher, 32 or 64 bit
Software:
Playonlinux,Wine and Steam.

Sebastian Stamm is currently living and studying in
Kassel, working as an animator, illustrator and VJ.
His works have been published by RotopolPress,
Pandemia and Crepes Comics. Over the last years,
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he worked on several animated shorts and
commercial projects for clients like VW, Studio
FilmBilder, Theater Bielefeld, Eon Bayern and Bilger
Film. He enjoys comics, good canned meat, old
videogame consoles, punk rock and ray guns.
At Black Pants, he creates the characters and story,
and contributes his visual style to the game.
web: www.thestamm.com
mail: thestamm(a)tinyandbig.com

Florian Grolig is an animation filmmaker and latterly
game designer from Kassel. In 2010 he finished his
studies at the School of Arts and Design Kassel with
the animated short „MS. Found In A Bottle“. During
his studies he realised some short films, did
experimental life video with ‘20 seconds harmony‘
and worked amongst others for Studio Filmbilder,
Phil Mulloy and BMW/Mini.
At Black Pants, he is reposible for level and
gamedesign and works on the 3D content.
web: www.panopticum.eu
mail: flo(a)tinyandbig.com

Sebastian Schulz started developing small programs
on his first brand new C64 in the early 90s. Later,
first small unfinished games followed on his first PC
using Visual Basic and Pascal. Soon after that he
switched to the objectoriented languages C++ and
Java and started to work with game engines like
JME and Irrlicht. In 2002 he started studying
computer science at the University of Kassel where
he met the other cofounders of Black Pants Studio.
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At Black Pants, he is responsible for the game‘s
physics, audio, A.I. and gameplay logic.
mail: sys(a)tinyandbig.com

Some Gameplay Screenshots

By continuously working on the Scape Engine since
2002, Johannes Spohr started to pursue his
enthusiasm for graphics programming professionally.
He spent much of his early efforts competing in the
PC demo scene, and has more than 15 years of
experience developing realtime graphics engines
under his belt.
He is Black Pants’ core engine lead, build engineer,
C++ warlock, and bearer of the Company Mustache.
mail: jones(a)tinyandbig.com

Tobias is an independent animation filmmaker. He
studied animation at the school of fine arts in Kassel.
During his stay in Kassel he did several animation
shorts which were shown at filmfestivals all over the
world. At Black Pants, works on the 3D content and
builds the levels.
web: www.bilgeri.eu
mail: tobi(a)tinyandbig.com
We are further accompanied by the following
tremendous persons, who are cool:
Alexander Draude – Concept Artist & Textures
Vincent Zurwesten – Music Spy
Federico Martin – 3D Animation
Julian Vavrovsky – 3D Modelling
Philipp Beau – Programming
Alexander Gerb– Programming
Alexander Jahl– Programming
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Game Zone: Tiny & Big
Getting It To Run
This game was installed using Playonlinux, which is
available through Synaptic. After you have
Playonlinux installed, click on the game tab to find
steam. It should install Wine version 1.5.25.
After Wine is finished and Steam is updated, search
for the game in the store and download the demo. It

ran very well on my end with 2.6 dual core amd and
nVidia 9600 with 4 gigs of ram. I know it is available
for Linux. However, since Steam isn’t 100% on
PCLinuxOS, I chose this route. I am going to keep
an eye on this company. It seems they know what
they are doing in the area of just good, fun game
play. If anyone has ever played Borderlands, it looks
similar with a different game engine. Have fun.

Screenshot
Screenshot Showcase
Showcase

Posted by RobNJ, May 15, 2013, running e17.
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by Kevin Keijzer
Shared via Google+

Refuse To Be Bullied:
Say NO To Proprietary Software

There are many valid reasons to reject proprietary
software.
Its
potential
risks
are
highly
underestimated by many, and in today's day and age
of computer technology, they pose a stronger threat
than ever.
Proprietary software shows no respect for the users'
freedom. Users are not allowed to know what the
software is doing on their own computers, nor are
they able to modify it if they have the need to. All
proprietary software users can do is "hope for the
best".
Proprietary software is not secure. You'll be left to
the mercy of companies like Microsoft, Apple, and
Adobe to have your interests at heart, of which you
cannot be certain. Chances are that if fixing
something will not generate enough income for
them, it will not be done, even though it may pose a
threat to your security.
Proprietary software can not be trusted. As there is
no way for you or anyone else to know what it is
doing on your system, there is no way for you to be
sure that it does not collect your personal data,
record audio through your microphone, record video
through your webcam, or monitor your keystrokes
and log your passwords. All you can do is hope or
assume that the vendor has not implemented
anything like this, but you can never be certain of it.
Proprietary software keeps you from owning your
possessions. After you have bought a piece of
proprietary software, you do not own it, even though
you paid for it. Therefore, the vendor will always
remain in charge of everything you can or can't do.
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When an update removes certain functionality you
may rely upon, there is no way for you to stop it. You
will never be sure that your computer keeps working
the way you expect it to, because proprietary
software vendors are not interested in you,
whatsoever.

computers in general. This decreases the chance of
more people developing or even installing free
software, and it will keep the ecosystem of "valuable
professionals" and "certified partners" up and
running, abusing people’s ignorance in order to
make more money from them.

Proprietary software is able to control the programs
you run and the files you use. Proprietary software
vendors are able to disallow you to run certain
pieces of software, such as Apple does with their
application stores. Also, they can keep you from
playing videos and music, for instance, because of
the DRM technology built into the cores of the
Microsoft Windows, Apple Mac OS, and Apple iOS
operating systems. You are denied the right to use
your computers, laptops, tablets, and phones for
whatever cause you see fit.

Proprietary software makes the world a worse place.
If all existing proprietary software would be open
sourced, nobody would suffer in any way from it. In
fact, it would only be better for everyone. The
developers would be able to get help from all around
the world, and get suggestions they might otherwise
never have received. The users would have a
product that is maintained by more people, and can
be sure that at least someone will look for "evil" code
that might be dangerous for their privacy, and
remove it. The companies behind the software would
reach a larger audience, and would more likely be
able to provide paid support to a bigger user base.
The quality, security and efficiency of the software
and the user experience will only benefit from being
free (as in freedom).

Proprietary software is able to lock you into closed
standards. When you rely on a proprietary program,
chances are it also uses proprietary file formats.
These files are generally impossible to use with
other (free) programs, unless developers reverse
engineer them, which might take years. Because of
that, relying on proprietary file formats means you
will be completely dependent on the vendor and the
direction they choose to turn.
Proprietary software has been pushed to become
the standard. Due to extensive lobbying, primarily by
Microsoft, many corporations have been led to
believe that endorsing proprietary software is the
right thing to do. Nearly everyone has grown up
using proprietary software exclusively, without
knowing they even had other options. Proprietary
software has not become widespread by choice, but
by force.
Proprietary software prevents mankind from
developing. Because you are unable to study the
software running on your computer, you are not
allowed to gain knowledge about it. It is in
proprietary software vendors' interest that people
know as little as possible about software and
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The other way around, things would be completely
different. If all currently free software would become
proprietary, every single aspect of it would become
worse. The developers would lose 90% of their
'colleagues' and be forced to work the way the suits
tell them. The users would no longer be certain that
the programs they are using are not abusive, and
will be forced to pay money for something they might
not be able to afford. The companies would only see
a decline in quality of service and user count, unless
they are capable of pulling off an ongoing worldwide
scam like Microsoft and Apple have succeeded in
doing.

paranoid as much as you want, but I simply refuse to
believe that the CEOs of multibillion dollar
companies will "do no harm." Only a fool would feel
that way.

Visit Us On IRC

• Launch your favorite IRC Chat Client software
(xchat, pidgin, kopete, etc.)
• Go to freenode.net
• Type "/join #pclosmag"
(without the quotes)

I am sure you believe there are plenty of advantages
to proprietary software. But that does not change
anything about the fact that it is always morally
wrong. Feel free to use it as you wish, but please do
not try to convince others to do the same.
Convincing people to harm themselves and others
around them is a terrible thing to do. You can call me
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International Community
PCLinuxOS Sites

Netherlands

Turkey
Denmark

Czechoslovakia

It's easier than E=mc2
It's elemental
It's light years ahead
It's a wise choice
It's Radically Simple
It's ...

Italy
Support PCLinuxOS! Get Your Official

PCLinuxOS

Poland

Merchandise Today!
Brazil
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More Screenshot Showcase

Above: Posted by parnote, May 4, 2013, running KDE.
Below: Posted by Crow, May 4, 2013, running KDE.
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Above: Posted by agmg, May 2, 2013, running KDE.
Below: Posted by Yankee, May 14, 2013, running LXDE.

Page 40

